
 
 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

  

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 اصل سوالات عمومی 

 آزمون استخدامی 

    1394 آموزش و پرورش

 

 توضیحات: 

 1394سال آزمون  •

 دروس عمومی  اصل سوالات  •

 با قابلیت پرینت  •

•  

iranarze.ir 

 بزنیداینجا  ،آموزش و پرورش برای دانلود رایگان جدیدترین سوالات استخدامی ادوار گذشته 

 بزنیداینجا  ،آموزش و پرورش همچنین جهت مشاهده آخرین اخبار استخدامی 
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 مطالب  فهرست

 2صفحه I.C.D.L - فناوری اطلاعات و مهارت های هفت گانه 

 3صفحه   -زبان و ادبیات فارسی

 5صفحه  -اطلاعات عمومی و دانش اجتماعی و حقوق اساسی  

 7صفحه  –ریاضی و آمارمقدماتی 

  9 صفحه –معارف و احکام اسلامی 

 11 صفحه  –هوش وتوانمندی های عمومی 

 16  صفحه –عمومی   –زبان انگلیسی 

 

  I.C.D.Lفناوری اطلاعات و مهارت های هفت گانه 

 (iranarze.ir) شود؟ می  نامیده باشد،چه دسترسی قابل ها مشتری از تعدادی برای که شرکت یک داخلی سایت وب یک از بخشی -1

1 )Extranet  2 )Intranet  3 )Internet  4 )Network 

 (iranarze.ir)  است؟ معنی کدام به ویروس کامپیوتر،آنتی  علم در -2

 .شود می کامپیوتر  به ویروس ورود مانع  که افزاری  نرم( 1

 . شود می کامپیوتر به ویروس  ورود نع   ما که  ی  افزار سخت ( 2

 .شود  می استفاده   ویروس کردن قرنطینه یا حذف و تشخیص جهت  که افزاری  نرم( 3

 . دهد می  اطلاع کاربر به کامپیوتر در ویروس وجود صورت  در  که افزاری سخت ( 4

 (iranarze.ir) کرد؟ استفاده باز پنجره چند  بین حرکت برای توان می موارد کدام  ویندوز، از عامل سیستم در -3

1 )Alt+F4  2 )Alt+Tab  3 )Alt+ Space  4 )Ctrl+Esc 

 ( iranarze.ir) ، چه نوع فایلی است؟Text.rarفایل  -4

 کاربردی برنامه  یک برای  موقت فایل یک (  2                                         متنی فایل یک -1

 فشرده  فایل  یک( 4                                   تصویر یک( 3

 مورد   دهیمفکدام  می   فشار  را  I  و  Ctrl  کلید  دو  و  کرده  انتخاب  را  شده  تایپ  جمله.کنیم  می  تایپ  جمله  یک  آن  داخل  و  کرده  باز  را  Wordجدید  سند  یک  -5

 ( iranarze.ir)  شود؟ می حاصل

        متن شدن  مورب( 2                            فونت شدن  ضخیم( 1

 صفحه  پهنای با متن  شدن همتراز ( 4                        متن  شدن  چین وسط ( 3

 1394سوالات آزمون استخدامی آموزش و پرورش 

 



 

 
 

 1394سوالات آزمون استخدامی آموزش و پرورش   3

 

iranarze.ir 

   (iranarze.ir) دهد؟ می نشان Word2007 سند یک در را Tab به مربوط تنظیمات  مورد،مسیرصحیح کدام -6

1)Home>paragraph>Tab    2 )Page Layout>Page Setup>Tab 

3 )Insert>Text>Tab   4 )View>Window>Tab 

 ( iranarze.ir)  کنید؟  می مراجعه  بخش کدام  ،بهWord2007سند یک حاشیه در  کادر  یک درج جهت -7

1 )Home  2 )Insert     3 )Mailings   4 )Page Layout 

 ( iranarze.ir)  گرفت؟ کمک باید کلید  کدام اند،از شده واقع متوالی طور به که سطر چند انتخاب ،جهتExcel فایل یک از کاربرگ  یک در -8

1 )Alt   2 )Ctrl   3 )Shift   4 )Tab 

   شود؟ داده  نمایش کسری شکل باشد،به می عدد فقط که سلول آن محتویات که شود می باعث کاربرگ یک از سلول یک برای عددی فرمت کدام انتخاب -9

1 )Accounting  2 )Currency  3 )Number  4 )Fraction 

 (iranarze.ir) گیرد؟ می قرار استفاده ، موردExcel فایل یک از کاربرگ یک های داده سازی مرتب جهت  مورد کدام -10

1 )Data > Filter       2 )Data > Sort 

3 )Insert > Chart       4 )Home > Conditional Formatting 

 ( iranarze.ir) است؟ کدام ها داده نمایش و ورود برای ابزار  ترین ،مناسبAccess محیط در -11

1 )Form  2 )Macro  3 )Modules  4 )Report 

 ( iranarze.ir)  شود؟ می مورد،استفاده کدام جاری،از اسلاید از Power Point فایل یک نمایش اجرای جهت -12

1 )F11  2 )F5  3 )Shift+F5  4 )Ctrl+F9 

 (iranarze.ir)  بود؟ خواهد مورد آن،کدام کنیم،پسوند ذخیره Show PowerPointنمایشی شکل به را فایل یک ، 2007Power Point محیط در اگر -13

1 )ppt  2 )potx  3) pptx  4 )ppsx 

 ( iranarze.ir)  کند؟ می  ذخیره را اید کرده مشاهده اخیرا که  وبی صفحات مورد،آدرس کدام  -14

1 )Bookmark  2 )Favorites  3 )History  4 )Tools 

 ( iranarze.ir) گیرید؟ می  کمک  ابزار کدام  الکترونیکی،از پست توسط فایل یک ارسال جهت -15

1 )Attach  2 )Copy-Paste  3 )Insert  4 )Upload 

 ( iranarze.ir)  گرفت؟ کمک باید کلید  کدام اند،از شده واقع متوالی طور به که سطر چند انتخاب ،جهتExcel فایل یک از کاربرگ یک در -16

1 )Alt   2 )Ctrl   3 )Shift   4 )Tab 

 

 زبان و ادبیات فارسی 

 ( iranarze.ir) است؟ ،کدام«استمالت»  واژهء معنی -17

 کردن  روی زیاده ( 4                جویی دل( 3                نیازی بی ( 2           برانگیختن( 1

 (iranarze.ir) است؟  آن،غلط مقابل معنی به توجه با واژه مورد،املای کدام در -18

 کردن  وصف:نعت( 4        شکستن:نقض( 3  درندگان : سباع( 2 گرفته  خو:معلوف( 1
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 ( iranarze.ir) دارد؟  وجود املایی  کلمه،غلط گروه کدام  در -19

 مقلوب   و مقهور – ودفتر  صحیفه( 2                       سنبل  طرهء – رستخیز و حشر ( 1

 فاخته   و سیره  – وتفاوت تعارض( 4                 فراموشی  و نسیان  -نازکدلی  و رقت( 3

 ( iranarze.ir) است؟ بهار الشعرای  ملک اثر،از کدام -20

 سعدی  کلیات تصحیح ( 2                                     مولوی مثنوی شرح( 1

 شناسی  سبک( 4                               الحکایات جوامع   تصحیح( 3

 (iranarze.ir)  است؟ «کامو آلبر»  از اثر کدام  -21

 مسخ ( 4          اسلحه با   وداع( 3                   سوءتفاهم( 2               محاکمه( 1

 ( iranarze.ir) است؟ زیر،کدام بیت شاخص آرایهء -22

 «نیل آب ز برد آتش بر گروهی                        خلیل بر آتشی کند  گلستان»

 تضمین ( 4  تلمیح  ( 3  تمثیل( 2  تشبیه  ( 1

 (iranarze.ir)  کدامند؟ زیر بیت های آرایه-23

 «ایم گشاده دل از گره تا ایم خورده  خون         سرا بوستان این در غنچه همچو عمر یک»

 تلمیح  – تشبیه( 2     استعاره   – تشبیه( 1

 تلمیح  -استعاره ( 4     ایهام   - کنایه( 3

 (iranarze.ir)  است؟ شده قالب،سروده کدام  در شعر،  باشد،آن بیتی ده شعر یک از بیت زیر،اولین بیت اگر-24

 « دوست روی وغم ما است خرمی جهان دو گر     دوست کوی سر خاک است من حیات آب» 

 غزل ( 4  قصیده  ( 3  مثنوی( 2  قطعه  ( 1

 (iranarze.ir)  دارد؟ مفهومی قرابت عبارت کدام زیر،با بیت -25

 «نیست کرم  را نعمت خداوندان                 نیست درم  اندر دست به را کریمان»

 .  ندارد  کس دنیا همه  ندارد،در  دسترس  دینار  بر   که آن( 1

 . در بی  خانهء علم بی  زاهد و است   بر  بی  درخت عمل بی  عالم ( 2

 . شکسته ارادت  پای را توانگر و است  بسته  قدرت دست را  درویش( 3

 . پر بی  مر معرفت  بی  روندهء و  است زر بی  عاشق ارادت   بی  تلمیذ( 4

 ( (iranarze.ir)  است؟ زیر،کدام بیت مفهوم -26

 « آن و این  بر تو دیده  را  او عکس                  نهان  طوطی آن توست اندرون» 

 ودیگران  خود استعدادهای گرفتن نادیده( 2                   نفس هوای  با مخالفت  و مبارزه( 1

 خویش  خویشتن  از  انسان شناخت عدم ( 4                       هستی جهان  اسرار  از  غفلت ( 3

 ( iranarze.ir) است؟ غلط نگارش نظر عبارت،از کام -27

 کردند  راترک مطالعاتی آموز،اردوی دانش  با معلم ( 2  کردند    شرکت  درجلسه آموزان  دانش و معلم ( 1
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 رفت  روزه چند  اردوی به   آموز دانش  با معلم ( 4 رفتند   مدرسه مدیر عیادت  به آموزان  دانش و معلم ( 3

 ( iranarze.ir) دارد؟ تفاوت دیگر های کلمه کلمه،با کدام  دستوری ساخت -28

 وبرخاست  نشست (  4            دادوستد ( 3                سوزوگداز (  2            زدوخورد( 1

 ( iranarze.ir) است؟ معمول و مناسب ، «سرو،قلم،هنر» های واژه همهء پسوند،با کدام گرفتن کار  به -29

 گاه ( 4             زار( 3            دان ( 2               ستان( 1

 (iranarze.ir) است؟ جمله  چند زیر،  بیت -30

 «زه گفت مه احسنت گفت فلک              ده گفت قدر و گیر گفت قضا»             

 هشت ( 4              هفت( 3                      شش ( 2                 پنج( 1

 (iranarze.ir)  است؟ گرفته صورت معنوی قرینهء به فعل مصراع،حذف کدام در -31

 تیز  برفتند  پایان باد آن  گر( 2                ربود در زمن  روزگاری  قضا ( 1

 نشناختم   قدر را روز آن من ( 4                   گیر امروز  طاعت  ره  جوانا( 3

 

 حقوق اساسی اطلاعات عمومی، دانش اجتماعی و 

 ( iranarze.ir)  شد؟ برگزار زمانی ایران،درچه اسلامی جمهوری اساسی قانون بازنگری پرسی همه -32

 1368 بهمن( 4        1368شهریور(  3            1368مرداد( 2         1368فروردین( 1

 ( iranarze.ir)   بود؟ کسی چه برعهده 1386سال تا  رهبری خبرگان مجلس ریاست -33

       مشکینی الله آیت ( 4 هشترودی   الله آیت ( 3 هاشمی   الله آیت ( 2 کنی   مهدوی الله آیت ( 1

 ( iranarze.ir)  گردید؟ پا بر مشروطه پادشاهان،حکومت از یک کدام زمان   مشروطه،در انقلاب از پس -34

 احمدشاه ( 4        رضاخان ( 3      شاه   محمدعلی( 2         شاه مظفرالدین ( 1

 ( iranarze.ir)   شد؟ برگزار زمانی  چه ایران،در اسلامی جمهوری  اساسی قانون تایید پرسی همه -35

 1358 فروردین( 4          1358مرداد( 3          1358آذر( 2            1358بهمن( 1

 ( iranarze.ir)  نیست؟ ایرانی معروف ی نویسنده احمد آل جلال  نوشتهء زیر آثار از یک کدام -36

 زدگی   غرب( 4       احتجاب  شازده( 3                      مدیرمدرسه( 2            والقلم نون   ( 1

 ( iranarze.ir)   است؟ کسی  چه ایران فوتسال تاریخ گلزن بهترین -37

 طیب  حسین( 4        وحیدشمسایی ( 3      حیدریان    محمدرضا( 2   زاده  حسن اصغر  علی( 1

 ( iranarze.ir)  است؟ مرز اژه هم دریای با باختر از زیر کشور  کدام -38

 سوریه (  4                     گرجستان ( 3                   ترکیه( 2                  بلاروس ( 1

 ( iranarze.ir)   گرفت؟ صورت عملیاتی چه طی خرمشهر  آزادسازی -39

 القدس  طریق( 4         المقدس  بیت ( 3                مرصاد( 2              المبین فتح ( 1
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  (iranarze.ir)  اند؟  نداشته  قرار  مذاکره  های  سال  طول  در  ای  هسته  مسئله  در  ایران  اسلامی  جمهوری   کنندگان  مذاکره  هیئت  راس  زیر،در  افراد  از  یک  کدام  -40

 لاریجانی  علی( 4  جلیلی   سعید( 3  ولایتی   اکبر علی( 2  جوادظریف    محمد( 1

 (iranarze.ir)  باشد؟ نمی زنان حقوق تضمین  در دولت وظایف مواردزیر،جزو از یک ایران،کدام اسلامی جمهوری اساسی قانون ویکم بیست اصل طبق -41

 سرپرست  بی  کودکان از  حمایت فرزندو وحضانت  بارداری  دردوران مادران،بالخصوص حمتیت( 1

 سرپرست  بی  و سالخورده زنان و ها  بیوه  خاص بیمه ایجاد( 2

 خانواده  بقای   و کیان  حفظ  برای   صالح دادگاه  ایجاد( 3

 تحصیل  ادامه ویژه،جهت تحصیلی های بورس اعطای ( 4

 (iranarze.ir)  است؟ بوده جهانی جام  در حضور به میلادی،موفق های سال کدام ایران،در  مردان فوتبال ملی تیم -42

1 )2014،2006،1998،1978                  2 )2010،2006،1994،1978 

3 )2014،2002،1982،1998                  4 )2014،2006،1982،1998 

 (iranarze.ir)نیست؟  ایرانی معروف ی نویسنده احمد آل جلال  نوشتهء زیر آثار از یک کدام -43

 زدگی  غرب ( 4         احتجاب  شازده( 3          مدیرمدرسه( 2           والقلم  نون( 1

    دارد؟ زیر،دلالت کشور  کدام به  «یک» شدند،عبارت دیپلملتیک مذاکرات وارد ایران  اسلامی جمهوری با که «یک» علاوه به پنج به موسوم گروه در  -44

 انگلستان ( 4             آلمان( 3               آمریکا ( 2                     روسیه( 1

 ( iranarze.ir)   بود؟ کسی  شد،چه کشته آغامحمدخان دست به که زندیه پادشاه آخرین -45

                          زند  خان ابوالفتح( 4 زند   خان  علیمراد( 3  زند   خان  کریم( 2 زند   خان لطفعلی( 1

 ( iranarze.ir)   است؟ شده تشکیل حزب چند و جزء  چند  کریم،از قرآن -46

1 ) 15 – 60               2 )30 –  60              3 )15 – 120               4 )30 – 120 

 کدامند؟   ترتیب داشتند،به دخالت فارس خلیج  فراز بر ایران اسلامی جمهوری مسافربری هواپیمای سقوط هولناک جنایت در که آن ناخدای و جنگی ناو -47

 راجرز  – وینسنس( 2                           ویلیامز  – روزولت( 1

 اسمیت  – آریزونا ( 4                        جکسون – اوکلاهما ( 3

 (iranarze.ir) است؟ زیر استان دو  کدام بین خونی،در گاو المللی بین تالاب قرارگرفتن محل -48

 کرمان   و فارس( 2            بلوچستان و  وسیستان کرمان ( 1

 فارس   و اصفهان( 4                               اصفهان  و یزد( 3

 ( iranarze.ir)   دارند؟ ویزا به زیر،نیاز کشورهای از یک کدام به مسافرت برای ایرانی اتباع -49

 مالزی ( 4               کنیا ( 3             ترکمنستان( 2                    ترکیه ( 1

 ( iranarze.ir)  بود؟ کسی مهاجمین،چه ضد بر مرصاد عملیات اصلی طراح -50

 شهیدصیادشیرازی ( 4         آرا شهیدجهان ( 3        کاوه  شهید ( 2            باکری  شهید( 1

 (iranarze.ir)  است؟ انگلیسی و ایران،اردو همسایگان از یک کدام رسمی زبان -51

 پاکستان ( 4                 ترکمنستان( 3             ترکیه ( 2              افغانستان ( 1
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    خورند؟ می سوگند برآن مذهبی های اقلیت کریم،نمایندگان قرآن کنار اسلامی،در شورای  مجلس در  که نیست کتبی زیر،جزو آسمانی کتب از یک کدام -52

 تورات ( 4               زبور( 3                 اوستا( 2                   انجیل( 1

 ( iranarze.ir)  اند؟ نداشته قرار ایران اسلامی جمهوری در قضائیه قوه ریاست زیر،برمسند  افراد از یک کدام -53

 لاریجانی  صادق الله آیت ( 2                          محمدیزدی الله آیت ( 1

 شاهرودی  سیدمحمودهاشمی الله  آیت( 4                      شیرازی   مکارم الله آیت ( 3

 (iranarze.ir) بود؟  زیر  افراد از یک قاجار،کدام سلسله پادشاه آخرین-54

      شاه ناصرالدین (  4        شاه   مظفرالدین ( 3          شاه محمدعلی ( 2               احمدشاه( 1

 (iranarze.ir)  کند؟ تابعیت سلب ایرانی فرد یک از تواند می صورت کدام  در اساسی،دولت قانون ویکم چهل  اصل طبق -55

 ایرانی  غیر کشوری در اقامت ( 2      قوانین    از  تخطی( 1

 دیگر  کشوری تابعیت  به   خودفردیادرآمدن  درخواست-4    ایرانی   غیر باتابعیت فرزندانی داشتن ( 3

 ( iranarze.ir)   شد؟ نایل چهارم مقام کسب  به جهانی لیگ کدام ایران،در  مردان والیبال ملی تیم -56

1 )2014                   2 )2013                 3 )2012                  4 )2011 

 

 ریاضی و آمار مقدماتی 

×  حاصل  -57 (√𝟐 − 𝟏)−𝟐 (√𝟐 +  ( iranarze.ir)  ، کدام است؟ 𝟐(𝟏

1 )     (3 − 2√2)2                           2  )(3 + √2)−2 

3 )  (17 − 12√2)−1                       4 )  (17+6√2 ) 

 ( iranarze.ir){ می توان ساخت، به طوری که فقط صفر یک در میان و تکراری ظاهر شود؟  0و1و2و3و4و5چند عدد شش رقمی با ارقام }  -58

1 ) 120                  2  )90                  3 )60                 4 )30   

𝐱𝟑عبارت   -59 + 𝟏𝟏𝐱𝟐 −  𝟑𝐱 + 𝐚   برx+1   بخش پذیر است. مقدارa ؟ کدام است(iranarze.ir) 

1 )15                      2  )9                 3 )7-                4 )13  ) 

 (iranarze.ir)کدام است؟    f(x)=0بخش پذیر است. بزرگترین ریشه معادله   x+1بر     𝟑𝐱𝟑 +a 𝐱  f(x)=𝐱𝟒 +چند جمله ای   -59

1 )  √3 1  )                2 ) √3 -1+            3  )   √7 1 )            4 )    √7 -1 )   

𝟑−   )1,6-(  )4,11( )7,اگر }  -60

𝟐
    f= {  (1,-2) ( وg={ (-3,8) (0,2) (5, -2) }  باشد، برد تابعf(

𝟏

𝟐
 g(x) )   کدام است؟(iranarze.ir ) 

1 ){-2,6,11}                     2 ) {-2,7,11}     3 )  {4,1,-1}                 4 )   {-1,3,4}      

 (iranarze.ir) ، شامل چند عدد طبیعی است؟)  5 𝐱 𝟐√𝟓 - 𝐱𝟐+ (3x-2) (  ≥ 0مجموعه جواب نامعادله   -61

 .ندارد  طبیعی عضو( 4                                3( 3                       2(  2                         1( 1

 (iranarze.ir)  کدام است؟   a9 – a7سه جمله اول یک دنباله هندسی باشند ، حاصل       a+2 و  a ،a  √𝟑اگر    -62

1 )18                        2 )27                           3 )54                            4 )63 
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باشد؟) جمله    8، .... و  2،    1چند تصاعد حسابی با قدر نسبت طبیعی بزرگ تر از واحد می توان ساخت به طوری که سه جمله ی این تصاعد یکی از اعداد    -63

 (iranarze.ir) نخست طبیعی است.(   

1 )5                         2  ) 6                  3 )7                   4 )8     

𝟑𝐱𝟐 ، یکی از ریشه های معادله mبه ازای کدام مقدار   -64 −  𝟔𝐱 + 𝐦 =  ( iranarze.ir) دو برابر ریشهء دیگری است؟   𝟎

1  )
27

2
                         2  )

8

3
                3 )6                4 )9 

 ( iranarze.ir) ، کدام است؟   𝐱 √𝟑 - 𝐱𝟐( 1کمترین مقدار عبارت     - 65

1 )   
3

2
                         2 )      

5

2
            3 )  

−3

4
                          4  )

−7

4
      

 ( iranarze.ir) کدام است؟ nقطع می کند. مقدار   (2,2 )و  (  1,1-)را در نقاط   mx + ny=1و   5x-7y=-4دو خط عمود  dخط  -66

1  ) 
−5

2
                        2 )  

5

24
                     3 )  

−1

3
                    4  )

1

36
               

𝐚قطع کند، حاصل   ( 1-,1)و   (2,4)، این دو خط متقاطع را در نقاط dهمدیگر را قطع کرده اند. اگر خط  x= -1 روی خط  ax+by=1و   3x-2y=5دو خط   -67

𝐛
  

 ( iranarze.ir)کدام است؟ 

1 )     
17

6
                   2 )    

1

3
                         3  )    

−7

2
                 4  )

−8

3
 

]     اگر -68
𝐚 𝟎
𝐛 𝐜

] =  𝐀−𝟏  معکوس ماتریسA=[
𝟏 𝟎
𝐱 −𝟏

 ( iranarze.ir)  کدام است؟ c b+باشد، حاصل  xبه ازای جمیع مقادیر      [

1 )x-1                      2) x+1     2 )     3) 1-x               4) –x-1 

]اگر  -69
𝟏 𝟏
𝟎 𝟏

−𝟏 𝟎
]   [

𝐚
𝐛

] = [
𝟏
𝟑

]     [
𝟐 𝟏 𝟏
𝟎 𝟏 −𝟏

 ( iranarze.ir) کدام است؟  a-bباشد، حاصل   [

1 )5                         2  )2                 3 )1 )                 4 )3 - 

N | 𝐧𝟐اگر -70 ≤ 𝟕}   A={n ∈ وZ| [m]=4 }    ∈ B={m  باشد، مجموعهB  A ∪ ( [0]دارای چند عضو است؟  ).تابع جزء صحیح است :(iranarze.ir) 

 5( 4                   3( 3              شمار بی ( 2.           ندارد عضوی( 1

 ( iranarze.ir)حرف وسط کلمه باشد؟  "و"چند کلمه پنج حرفی می توان ساخت به طوری که حرف  "آموزش "با حروف کلمه  -71

1 )120             2 )96               3 )54                  4 )24 

 ، تنها به صورت عدد حسابی باشد،نوع متغیر تصادفی نمرات کدام است؟  4اگر نمره کسب شده معلمان در یک دوره ضمن خدمت براساس نمره ی صفر تا -72

 گسسته  کمی( 2                                     پیوسته کمی ( 1

 ترتیبی  کیفی ( 4                                      اسمی کیفی( 3

 (iranarze.ir) برای داده های جدول زیر ،زاویه مربوط به دسته سوم در نمودار دایره ای، چند درجه است؟ -73

 

 دو جامعه دارای مقیاس های اندازه گیری متمایز هستند. برای مقایسه پراکندگی داده های آماری دو جامعه، کدام شاخص مناسب است؟  -74

 معیار  انحراف( 4  واریانس  ( 3 تغییرات  دامنه( 2 تغییرات   ضریب( 1
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 (iranarze.ir)  کدام است؟  1302، 1307، 1303، 1304، 1299واریانس داده های   -75

1 )4.5                       2 )4.3              3 )6.8              4 )6.4 

صندلی هستند. با فرض خالی بودن همهء    7صندلی دارد،سایر ردیف ها دارای    4ردیف صندلی است، به طوری که به جز ردیف اول که    5دارای    Aکلاس    -76

 ( iranarze.ir)ول را برای نشستن انتخاب نکند،کدام است؟  صندلی ها ، احتما ل اینکه احمد،ردیف ا

1 )   
4

5
                         2 )  

1

5
                           3 )   

1

8
                         4  )

7

8
  

 ( iranarze.ir)کدام متغییر،کیفی ترتیبی است؟  -77

 زلزله  شدت(  4            خونی گروه ( 3               تحصیل دوران( 2                    ها رنگ ( 1

 (iranarze.ir)  دسته باشد،مرکز دسته دوم کدام است؟5، حدود دسته سوم جدول فراوانی با (40 (32)اگر   -78

1 )30             2 )28             3 )26                 4 )24     

 ( iranarze.ir) زیر،دسته بندی شده است. میانگین جامعه کدام است؟داده به صورت  15جامعه آماری با  -79

 

1 )12.6                     2 )13.9                     3 )14.6                4 )15.9 

 (iranarze.ir) ، کدام است؟ 1257و  1259، 1260، 1258، 1256واریانس داده های  -80

1 )2                          2 ) 3                            3 )2.5                          4 )3.5 

 (iranarze.ir)  خانواده ای دارای سه فرزند دختر است. احتمال اینکه فرزند چهارم پسر باشد،کدام است؟   -81

1 )   
1

16
                       2  )  

1

8
                      3 )   

1

4
                  4  )

1

2
 

 

 معارف و احکام اسلامی 

  مفهوم   موضوع   کدام  «آورند  می  پناه  او  ازهرچیزبه  ونامیدی  نیازها،سختیها  هنگام  مخلوقات  همه  که  است  همان   الله: »فرمودند  که(  ع)   صادق  امام  حدیث  از(  82

 ( iranarze.ir)گردد؟   می

 انسان  درونی گرایش( 2                                خداشناسی بودن فطری ( 1

 انسان  فطری گرایش( 4                                خداپرستی بودن فطری ( 3

 ( iranarze.ir)  ریشه بحران های فراروی انسان ناشی از کدام امر است و قرآن کریم زندگی تنگ و سخت رامعلول کدام مورد می داند؟( 83

        ازخدا  روگردانی - ناشناسی  خدا( 2                       ازخدا روگردانی - شناسیخودنا ( 1

        فطرت  از غفلت -ناشناسی خدا   ( 4                        فطرت از  غفلت  - خودناشناسی( 3

 (iranarze.ir) خداوند،چگونه انسان ها را به صورت ویژه هدایت نموده است؟ ( 84

 ها  انسان   میان در  رقابت حس ایجاد و متفاوت  خلقت   با( 1

 دین  اختیار،بافرستادن  و تعقل  ویژگی دو با متناسب ( 2
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 متفاوت  ونژاد گوناگون شعبات با   مختلف اقوام  خلقت( 3

 . کنند دعوت مختلف  ادیان   رابه  مردم تا فرستاد را  پیامبرانی ( 4

مسلما نان وظیفه دارند جامعه را براساس کدام مورد بنا کنند و برترین مقام    ﴾   لقد ارسلنا بالبینات و انزلنا معهم الکتاب و المیزان ...  ﴿با توجه به آیهء شریفهء  -85

 ( iranarze.ir)رسول خدا)ص( کدام است؟  

 معنوی ولایت -خدا کتاب (  2                                ظاهری ولایت -  خدا کتاب( 1

      معنوی ولایت -  قسط( 4                                      ظاهری  ولایت  - قسط ( 3

 (iranarze.ir)حدیث شریف منزلت در شان چه کسی بود و منزلت هارون نزد موسی)ع( کدام مورد است؟ -86

 مردم  هدایت  امر  در وشریک یبان مشاور،پشت - (ع) علی حضرت( 1

 مردم  هدایت  امر  در  وشریک مشاور،پشتیبان  - ( ص )محمد  حضرت( 2

 شما  میان در من  جاشین و  وصی برادر،    - (ع) علی حضرت( 3

 شما  میان در من جاشین   و  وصی برادر،    - ( ص )محمد  حضرت( 4

 ( iranarze.ir)امامان معصوم)ع( چگونه تلاش کردند تا از تحریف اسلام جلوگیری کنند و مردم را از ظلمت به روشنایی برسانند؟  -87

 آن  تحریف  رفع  و  قرآن آوری جمع  برای   اقدام  و خلفا دربرابر  سکوت( 1

 ظاهری  ولایت و  دینی مرجعیت به  مربوط  های مسئولیت  انجام  برای قیام( 2

 قرآن  وتفسیر تعلیم همراه به   پیامبراسلام ی سیره  و سخنان  حفظ برای اقدام ( 3

 اسلامی  نهضت وایجاد شیعیان آوری جمع  برای   تلاش و  حق  بر  امام عنوان  به خود  معرفی( 4

 ( iranarze.ir) کدام مورد،بیانگر وظیفهء فقها در دوران غیبت امام زمان )عج( می باشد؟ -88

 .سازند آماده را  خود  آنان وهمانند بداند  خوبی به  را   امامان  و پیامبر زمان  ومسایل احکام( 1

 .آورند دست به  نیفتاده  اتفاق وامامان پیامبر زمان در  که  را جدید رویدادهای و ،مسایل  احکام( 2

 . نمایند  صادر  را لازم   احکام بتوانند ظهور  درزمان  تا نمایند  اسلامی منابع  دقیق ی مطالعه  صرف   را  خود وقت ( 3

 . کنند راهنمایی  را حاکمان   اسلام  قوانین براساس  بتوانند  مردم مشکلات حل  از حاکمان  ناتوانی درصورت( 4

 ( iranarze.ir)کدام مفهوم در یافت می شود؟  ﴾ ....  تَرَکتُ فِیما صالِحاً أَعملَُ لَعَلِّی ارجِعُونِ،  رَبَ قالَ اَلمَوتُ أحَدََهُمُ جاءَ  إذِا حتَی ﴿ از دقت در آیه شریفه -89

 .یابد می ادامه  جسم و روح  آگاهانه فعالیت  برزخ  عالم در( 1

 .شود  می بیشتر مرگ از  بعد   انسان آگاهی و درک حیطه ( 2

 .شود  می بسته او  اعمال پرونده و  شود می  سلب انسان از  اختیار ( 3

 . کنند می توفی است جسم  و روح همان  که  را  انسان  وجود  حقیقت فرشتگان( 4

 ، به ترتیب منجر به تحقق کدام یک از انواع کیفر میشود؟  « خود را محاط در نتایج اعمال خویشتن یافتن » و    « ابتلای به بیماری در اثر عدم رعایت قوانین بهداشتی »  -90

                       عمل محصول -طبیعی( 4                            عمل  محصول - ملع عین( 3  اخروی  - عمل عین( 2   اخروی -طبیعی ( 1

 ( iranarze.ir)  حساس ترین و ارزشمندترین دورهء عمر انسان،کدام دوره است و به چه دلیل؟( 91

 .است آگاهی  و معرفت تقویت  و رشد دوره  -جوانی  و نوجوانی( 1

 . است آگاهی و  معرفت تقویت و رشد دوره  -ازدواج تا بلوغ ( 2
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 . باشد  می پاکدامنی و  عفاف تقویت دورهء-جوانی  و نوجوانی( 3

 .باشد می  پاکدامنی و عفاف تقویت دورهء  -ازدواج تا بلوغ ( 4

 (iranarze.ir) به ترتیب از کدام نوع گناهان است؟ «رشوه گیری  »و  «بی توجهی به عفاف و پاکدامنی  »( 92

 اجتماعی   توبه ونیازمند اجتماعی،فردی(  2                  فردی توبه نیازمند   و فردی فردی، ( 1

 فردی  توبه نیازمند و اجتماعی  فردی، ( 4           اجتماعی توبه ونیازمند  اجتماعی،اجتماعی( 3

 ؟  عامل اصلی وحدت جامعهء اسلامی،بر مبنای کدام مورد است و برای انجام این مسئولیت)وحدت(،ابتدا باید یکدیگر را به کدام امر دعوت کنیم ( 93

 یامرون بالمعروف   –واعتصموا بحبل الله ( 2یدعون الی الخیر                     -فالف بین قلوبکم( 1

                   الخیر الی  یدعون – الله بحبل  واعتصموا( 4بالمعروف                    یامرون  -قلوبکم بین فالف( 3

 ( iranarze.ir)لباس نمازگزار نباید از حیوان حرام گوشت باشد.اگر  مویی از آن،همراه نمازگزارباشد،نمازش چه حکمی دارد؟  ( 94

 مکروه ( 4                        مباح( 3                        باطل( 2                   صحیح( 1

 (iranarze.ir)   زکات چه نوع انفاقی است و به چه چیزهایی تعلق می گیرد؟ -95

 کشمش  و گندم،جو،خرما - مستحب( 2                      کشمش و گندم،جو،خرما  -واجب( 1

 نقره   و برنج،گندم،طلا -مستحب ( 4                           نقره و برنج،گندم،طلا   -واجب( 3

 ،به ترتیب ناظر بر کدام حکم است؟ «چیز پاک اگرشک کند نجس  شده است یا نه»و  «چیز نجس که انسان شک دارد پاک شده است یا نه» -96

 نجس  -  پاک( 2                                             نجس  - نجس( 1

 پاک  – پاک( 4                                              پاک – سنج ( 3

 

 هوش و توانمندی های عمومی 

   (iranarze.ir)در جدول زیر به جای علامت سؤال کدام گزینه را می توان قرار داد؟  -97

2 31 1 

3 52 2 

 3 63 ؟

1 )3                        2 )2                     3 )4                      4 )1 

 ( iranarze.ir)دقیقه خواهد شد.الان ساعت چند است؟   30و   5ثانیه دیگر ساعت  140  -98

 دقیقه  وچهل ونه  پنج( 2                                     دقیقه  ویازده چهارده ( 1

 دقیقه  ویک  وپنجاه چهار ( 4                              دقیقه  یازده  و پنج( 3

 ( iranarze.ir) سعید بلندتر از مسعودوکوتاه تر از حمید است. حامدکوتاه تر از سعید اما بلندتر از مسعود است. قد کدام یک از همه بلندتر است؟  -99

 مسعود ( 4                  حامد ( 3                سعید( 2                   حمید( 1
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 ( iranarze.ir) با توجه به شکلهای مقابل مقدار ؟ را بیابید:  -100

                       

1 )16             2 )18                  3 )38                4 )58 

 ( iranarze.ir)در دنباله حروف زیر مجهول چه حرفی است؟  -101

 ) ژ ، ص ، ر ، ط ، د ، ع ، ؟ ( 

 خ ( 4                ح( 3                  چ   ( 2               ج  ( 1

 علامت بزنید.سؤال بعدی انتخاب کنید و در پاسخنامه   4راهنمایی: متن زیر را به دقت بخوانید و صحیح ترین پاسخ را برای 

که  صادها عضاو متحرک   کوچکیریق به بدن انساان وارد خون وی می شاوند. برخلاف روبات های  زمحققان در حال سااخت ریز روبات های اجتماعی ای هساتند که پس از ت

، به اندازه یک موجود تک سالولی اسات و از طریق رگ های خونی   دارند ، این روبات ها از نژاد متفاوتی هساتند و تماما از مواد شایمیایی سااخته شاده اند. هریک از این روبات ها

دارو حمل می کنند.دکتر فرانتیسک استپانک ، که به عنوان مهندسی شیمی در کالج سلطنتی لندن فعالیت می کند،   به بخش هایی از بدن که غدد آن در حال شاکل گیری اند،

می گوید: » ساطح روبات ها به گونه ای طراحی شاده که خود را به سالول سارطانی رساانده و به آن می چسابند.ساپس  شایمیایی اسات. وی   در حال کشات اولین نمونه روبات های

نبع اساتفاده از فرومون،یکدیگر را به م  به صاورت ناگهانی تعداد زیادی روبات در سالول انباشاته شاده و با آزاد کردن دارو ،سالول سارطانی را از بین می برند.«.همانند حشارات که با

ای ریزی  کنناد،این ریزروباات هاای اجتمااعی  نیز از طرق سااایگناال هاای اجتمااعی باا یکادیگر ارتبااط برقرار می کنناد.پوساااتاه ی بیرونی روباات هاا از منفاذهاغاذایی راهنماایی می  

ید :» وقتی روبات تنهاسات ،منفذهایش بساته می ماند.اما  پوشایده شاده که تعیین می کنند چه موادی وارد روبات شاوند و چه موقع محموله  آن آزاد شاود.دکتر اساتپانک می گو

یک سایگنال به بقیه روبات هاسات.  زمانی که روبات ها با یکدیگر هساتند و  روی یک هدف قفل کرده اند،ناگهان غلظت مولکول آزاد شاده هر روبات ،بیش از اندازه می شاود واین  

و ماده شایمیایی فعال شاده را جهت خنثی کردن هدف آزاد می کنند.«با وجود ترس اولیه،رها کردن ریز روبات ها    همگی به محض دریافت سایگنال ،منفذهای خود را باز کرده

ود را رها می کند.که در در بدن انساان ، روش مطمئنی برای تزریق دارو سات.هر روبات برای سامی بودن بسایار کوچک اسات و جمعیت روبات ها ،فقط وقتی محموله دارویی خ

تاکنون موفق به یافتن راهی برای    نظر جمع شاده باشاد. دو ساال اسات که اساتپانک روی این پروجه پنج سااله کار می کند. کار زیادی در پیش اسات اما او و گروهش ، محل مورد

قابله با انتشاار موادشایمیایی یا پاکساازی  آزادکردن محموله های ریز ربات ها شاده اند. ریز روبات ها را می توان با هر وظیفه ای ساازگار کرد. از چنین روبات هایی می توان برای م

 محیط استفاده کرد.

 (iranarze.ir) ها،صحیح است؟  براساس متن،کدام مورد درباره ریز ربات  -102

 . اند شده ساخته  هدف یک برای   تنها( 1

 . شوند می  ساخته  سرطانی های  سلول توسط ( 2

 . دارند برعهده  را  خون در دارو آزادسازی و  انتقال وظیفه( 3

 . کنند می عمل  هم از سرطانی،مستقل های  سلول با مبارزه  در( 4

 (iranarze.ir)هدف اصلی نویسنده در پاراگراف دوم متن،کدام است؟   -103

 سرطانی  های سلول  بر  ها روبات  ریز تاثیر بررسی ( 2          یکدیگر  با  ارتباط در  ها روبات  عملکرد توضیح ( 1

 حشرات  با   ها روبات  ریز مقایسه( 4   ها   ریزروبات  فیزیکی  ساختار  توصیف ( 3

 ( iranarze.ir)متن به کدام پرسش زیر،پاسخ نمی دهد؟    -104

 کنند؟   می ایفا  نقشی  چه ها ریزروبات  بیرونی  پوسته در موجود منفذهای( 1

 کنند؟  می برطرف   را  ها سلول  غذایی نیازهای  ها روبات  ریز  چگونه( 2
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 شود؟   می استفاده  موادی چه   انتقال برای ها  ریزروبات از ( 3

 است؟   چگونه ها روبات  ریز  شیمیایی و فیزیکی ساختار ( 4

 ( iranarze.ir)کدام مورد، لحن نویسنده متن را درباره ریزروبات ها به خوبی بیان می کند؟    -105

 بینانه   خوش( 4                        غیرعلمی( 3               نگران(  2                علاقه بی ( 1

بعدی لازم است موقعیتی را که در هر سوال مطرح شده، مورد تجزیه و تحلیل قرار دهید و سپس گزینه ای را که فکر می کنید پاسخ مناسب  سوال    4راهنمایی:برای پاسخگویی به  

ه و قابل استنتاج است.  بیان نشد  تری برای آن سوال است،انتخاب کنید. هر سوال را با دقت بخوانید  با توجه به واقعیت های مطرح شده در هر سوال و نتایجی که بیان شده و 

 پاسخی که صحیح تر به نظر می رسد را انتخاب نموده و در پاسخنامه علامت بزنید.

در اندک بودن منابع ژورنالیسمم، به  ، قایع دارند، مشمترک اند. فرق رویکرد این دو اما  اژورنالیسمم و تاریخ نگاری اگر چه یکی نیسمتند. اما در نسمبتی که ب -106

ها آرتیزان داده های حقیقی اما   ها و مشماهدات اسمت. حقیقتی که ژورنالیسمت به آن می پردازد، حقیقتی اسمت متواضمع و ژورنالیسمت  حد کافی ورز ندادن داده

 خرد هستند.  

 ( iranarze.ir)؟  کدام مورد را می توان از اطلاعات مندرج در متن فوق، به درستی استنباط کرد

 .نیست  مشاهدات و دادهها دادن  ورز به نیازی   نگاری،  تاریخ در( 1

 .  دارد اختیار در جورنالیست که است منابعی از  بیشتر  مورخ، برای موجود منابع (2

 .  است آن تفسیر بلکه نیست،  خبر  گزارش دارد، را اصلی اهمیت  جورنالیسم در آنچه (3

 .کنند می اشتباه امر  حقیقت  در کنند،  می فرض جدا  را   نگاری  تاریخ و جورنالیسم  که  کسانی( 4

تبدیل  دانشمی که یک بار به طور کامل مسمتندسمازی شمده و به صمورت نوشمته بیان شمده اسمت، می تواند کم کم به  اشمتراک گذاشمته شمود. به عبارت بهتر،  -107

دانش دارد که در آن جا می توان آن را تحت مدیریت و مشمارکت قرار داد. در غیر این صمورت، این   پایگاه  عنواندانش به مسمئله انتقال، بسمتگی به سمازمانی به 

 دانش کاملا شخصی باقی می ماند و انتقال آن غیرممکن خواهد بود.

 (iranarze.ir) وق، بر کدام یک از مفروضات زیر بنا شده است؟فنتیجه گیری متن 

   است دانش  پایگاه گذرگاه  دانش،  توزیع برای   راه  تنها (1

 .باشد داشته هماهنگی باید   آن انتقال   موجود ظرفیت با میشود، تولید  که دانشی  میزان (2

 . است دانشی انتقال  - ازمجاری   آنها کنندگان تولید  ناآگاهی  ها، دانش برخی   ماندن شخصی دلیل( 3

 .باشد داشته را  دانش پایگاه در پذیرش برای   لازم مقبولیت آنها، دانش تا کنند دقت  خوب  دانش،   مستندسازی کار  در باید   دانشمندان( 4 

هایش را تا حدی   س برای دور زدن، یکی از بالگم  .درجه تغییر جهت دهند  120بار بال زدن،    18زنند و می توانند طی    بار بال می  250ها در هر ثانیه،    سمگ  -108

کند  س فکر  گاینکه م  بهبدون نیاز  و  پیچی کار می کندمارر  فنشبیه یک    ، لهضاین ع  دهد  خود انجام می  صل به بال  کج می کند و این کار را به کمک عضلات مت

 . ............... (iranarze.ir) 

 . کند می  زیاد  و کم را  آن  هایی زدن بال تعداد ( 1

 . کند می انتخاب   آن برای را  پرواز  درست مسیر  غریزی، طور به( 2

 . دهد می تغییر را حرکت  جهت  آن، عصبی کار   خود دستگاه  کمک  به( 3

 .دهد می تغییر را  مگس  حرکت جهت  و شده کج کند، می انتخاب   که  مسیری در خود،  به خود ( 4

  500سال گذشته، در حد یک درصد متوقف مانده است،در حالی که تعداد معادن فعال کشور طی این مدت، از حدود  20سهم معدن در اقتصاد کشور در    -109

 ( iranarze.ir) است.  میلیون تن افزایش یافته 390به بالغ بر  ، میلیون تن 120حدود معدن افزایش یافته و میزان تولید از  5400ومعدن به 

  سازد؟ می برطرف را متن در موجود ظاهری تناقض وجه بهترین شود،به فرض صحیح  که صورتی مورد،در امکد
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 .  کنند نمی کار خود  ظرفیت تمام  با   موجود، معادن( 1

   میشوند صادر خارج  به  داخلی استفاده  جای  به معدنی،  ازتولیدات بسیاری( 2

 .  است نداشته  پیشرفتی و  است گذشته  مانند به  معدن، صنعت   در فناوری  از استفاده( 3

 .است بوده  معدن  صنعت در  مربوطه رشد با متناسب  اقتصادی،  های  بخش  دیگر در  بازدهی رشد   نرخ( 4

   سوال بعدی پاسخ دهید.  4راهنمایی: با توجه به اطلاعات زیر به 

را بر اسماس   Sو  Y ،X   ،Zشمرکت قرار اسمت چهار پسمت   هسمتند. مدیر یک ،   1T  ،2 T ،3T   ،4Tهای  هر کدام دارای یکی از مهارت،   Dو A   ،B  ،Cچهار نفر به اسمامی  

 :مواجه است  ، های زیر با محدودیت ، واگذاری پست ها به افراد های این افراد، به آنها واگذار کند. این مدیر در مهارت

B پست  ایبرY  .مناسب نیست 

 دارد. 4Tمهارت نیاز به  Zپست  

C  2دارای مهارت T  .است 

 را ندارند. 3Tشود، هیچ کدام مهارت  به وی واگذار می Xو نه کسی که پست  Aنه 

 ( iranarze.ir)است؟  کدام مهارت و کدام پست    دارای  Aاست، به وی واگذار شده باشد،   1Tدارای مهارت  Bبه دلیل اینکه  Sاگر پست  -110

1 )1T ، Y                  2 )1T ، S                  3 )1T ،   X                           4  )4T  ،Z 

 ( iranarze.ir) ، صحیح است؟ Bشود. کدام مورد درخصوصی  واگذار Dبه  xاگر پست  -111

  است   4T مهارت  دارای ( 2 .                      است  3T مهارت  دارای ( 1

 . است شده واگذار  وی به   Z پست  یا است  4T مهارت دارای یا( 4 .   شود می  واگذار وی به   ، Z پست( 3

 (iranarze.ir)   است؟ صحیح لزوما مورد،  کدام  شود،  واگذر A به Y پست اگر -112

 .شود  می واگذار B به   ، S  پست( 2.                   شود می  واگذار B به    Z پست( 1

 .شود می واگذار  D  به  ، Z پست( 4.               دارد  3T مهارت   به نیاز   ، S  پست( 3

 (iranarze.ir)  شود؟ می مشخص طورقطع نفر،به چهار این  از چندنفر مهارت نوع ، واگذارشود B به ،  Z پست اگر  -113

1 )4                         2  )3                   3 )2                            4 )1 

 راهنمایی: چهار سوال بعدی را به دقت بخوانید و پاسخ صحیح آن رادر پاسخنامه علامت بزنید.   

 ( iranarze.ir)در رشته اعداد زیر، از چپ به راست، بین اعداد ارتباط خاصی برقرار است. به جای علامت سؤال کدام عدد باید قرار گیرد؟   -114

               28  ,   38   ,  49  ,  62  , 70   , 77   ,    ?                                                           

1 )85                      2  )87              3 )89                  4 )9 

   (iranarze.ir)  دارد؟ وجود مثلث چند روبرو،  شکل در -115

 

1 )28              2 )32                3 )36                          4 )40 
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  تغییری   آن محیط  تا  یابد  افزایش  باید  صد  در   جند مستطیل  این  عرضی  یابد،   کاهش  درصد  60.  است  4 به  3  آن  طول   به  عرض  نسبت  که مستطیلی  طول  اگر  -116

 ( iranarze.ir)   نکند؟

1 )75                       2 )45                                3 )96                           4 )80 

 بیشتر  مسئله  C ،  10  به  نسبت  B  به  وی  اگر.  کند  می  تقسیم  3  و  2،4   های  نسبت  به  ترتیب  به  C  وA ،B  اسامی  به  آموز  دانش  سه  بین  را  مسئله  تعدادی  معلمی  -117

 ( iranarze.ir)  است؟ داده مسئله چند A  به باشد،  داده

1 )10                       2 )20                              3 )30                            4 )40 

  ارتباط  این  تا  بگیرد  قرار  باید(  4  تا  1  موارد)    الگو  کدام  سؤال  علامت  جای  به .  دارد  وجود   خاصی  ارتباط   الگوها  راست، بین  به چپ بعدی، از  دو سوال  در :  راهنمایی

  .شود حفظ

118-  (iranarze.ir ) 

 

 

119-  (iranarze.ir ) 

 

 

 

 سؤال،کدام   علامت  جای  به.است  برقرار  بالا  تساوی  در  که  است  برقرار  ارتباطی  همان  پایین،   تساوی  در  که.است  شده  ارائه  تساوی   دو  سؤال بعدی،   در:  راهنمایی

  قراربگیرد؟ باید( 4تا1 موارد) الگوی

120-  (iranarze.ir ) 
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  باید(  4تا1  موارد)  الگو  سؤال،کدام  علامت   جای  به.  شوند  می   تبدیل  راست  سمت  الگوی  به   خاص  ای  قاعده  طبق  چپ  سمت  الگوهای  سؤال بعدی،   در:  راهنمایی

  قراربگیرد؟

121-  (iranarze.ir ) 

 

 

 عمومی  -زبان انگلیسی 

- 122  Scientists have set up so many experiments to ……. How earthquakes happen .. (iranarze.ir) 

1)  Tend   2) Solve   3)Find out   4)Keep 

-123   This is a very light chair. It is … of a series of aluminum tubes. (iranarze.ir) 

1)  Composed   2)Consist   3)Aware   4)Afraid 

- 124  Moslems … Their shoes whenever they want to enter a mosque.  (iranarze.ir) 

1)  Keep on   2) Take off   3) Put on   4) Turn off 

125- The teacher asked the student … lesson 5. (iranarze.ir) 

1)  That she had studied       2) That she has studied 

3) If she had studied       4) Has she studied . 

126- This must be kept a … between us. Nobody should know it. (iranarze.ir) 

1)  Covered   2) Secret  3) Known   4) Puzzle 

127- The stories … either in English or Persian.  (iranarze.ir) 

1)  Can be told   2)Will tell   3) Can tell   4) Can be tell 

128- If had treated her well she …  (iranarze.ir) 

1)  Wont leave   2) Dose not Leave       3) Had Left                4) Would not have left 

129- … , follow the directions on the bottle carefully.  (iranarze.ir) 

1)  When taking drugs      2) When one takes drugs 

3) When, in taking drugs      4) Wen taken drugs 

130- These Flowers are really beautiful although they are…  (iranarze.ir) 

1)  Artificial   2) Official   3) Special   4) Social 

-131   Before anyone could photograph the strange looking bird,…  (iranarze.ir) 

1)  It was flying away 2) It has flown away 3) It had been flying away  4) It flew away 
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- 321  They are my best friends, I always respect…  (iranarze.ir) 

1)  Their   2) They   3) Them   4) Themselves 

- 133  Created something which did not exist before means. (iranarze.ir) 

1)  Discover      2) Calculate 

3) Invent      4) Involve 

 -134  I wish you … it last week.  (iranarze.ir) 

1)  Sent   2) Could sent   3)Could have sent             4)Have sent 

135- Are you still here? You were here half an hour ago. Who…for?  (iranarze.ir) 

1)  Do you wait  2) Did you wait  3) Had you waited              4) Are you waiting 

136- The world is changing all the time, so are words. This sentence means that… ?  (iranarze.ir) 

1)  The world is changing, not words 

2) Words are changing, not worlds 

3) Only worlds are changing all the time 

4) Not only the world but also words are always changing 
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